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DIGITAL AUTHORING PRACTICE

Building A Solution
Learning Outcomes
Students should be able to:
• use the following features of a database application to support the implementation of a solution from a
design document:
–– Relationships
–– Simple and complex queries
–– Menus and macros
–– Validation
–– Lookup lists
–– Input masks
–– Forms and subforms
–– Reports ( including grouping, sorting,calculations and headers and footers)

Building A Relational Database
Relational database systems with user-friendly
graphical user interfaces can be built using
programs such as Microsoft Access. The underlying
code is therefore largely hidden from the database
developer, simplifying the process. Once a plan is in
place:
1. TABLES are built first to hold the data in
RECORDS, each of which subdivides into
FIELDS. Each field must conform to data type
rules, which is one of several validation (see
next point) techniques used. All records in one
table have the same fields.
2. VALIDATION rules can be applied to the tables’
fields to help to keep the data sensible and
in the correct format. Techniques such as
enforcing length checks, presence checks, type
checks and range checks are usually applied
to prevent data which violates the rules from
ever being accepted and stored. Two validation
techniques of particular interest are FORMAT

CHECKS (achieved using input masks) and
LOOKUP LISTS.
3. QUERIES can be written to process data. These
could be SELECT queries that gather data
together from the fields of multiple tables
and perhaps perform calculations, sorting and
other processes. Queries that go beyond simply
showing data are known as ACTION queries
and they can do jobs such as deleting records,
copying records between tables or making new
tables.
4. FORMS can be developed to facilitate the input
of data. These will include fields that the user
can type into and buttons that the user can
press. Some forms contain SUBFORMS because
the outer and inner forms have a relationship
that expresses the nature of the connection
between the data shown in each form. Forms
may show data directly from tables or from
query outcomes.
5. REPORTS can be developed for on-screen and
printed output. Reports may show data directly
from tables or from query outcomes.
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6. MACROS can be developed to group sequences
of commonly-executed tasks into single
commands. The user interface can then include
buttons which, when pressed, execute the full
sequence of commands stored in the macro
using the current data found in the tables at
the time of execution.
7. MENUS can be developed (using switchboards
and perhaps additional forms) to unite all of
the GUI components together and give the end
user a much more user-friendly front-end to the
system.
This fact file will follow the development of
a simple two-table database for a private
running coaching company called Marazeal
Running who bring together adult runners
with coaches that can enhance their
performance. Readers of this fact file are
encouraged to work through the document in
sequence and in full, developing the Marazeal
system.

Setting Up Tables
Marazeal Running needs to store data about:
• Coaches
• Runners
Since the data held about Coaches will be very
different to what the business needs to store about
Runners, these will be held in 2 separate tables.
Furthermore, there will be a relationship between
the 2 tables:

Coaches

Runners

This shows that:
• over the lifetime of the database, each Coach can
at any one time be coaching multiple Runners
(although in practice there may actually be
periods where they are linked with just one or else
not linked with any)

• over the lifetime of the database, each Runner
can at any one time be using only 1 Coach
(and we are going to make it a rule that they are
always linked with a Coach because it would not
be acceptable to have a Runner’s details stored
by the business if they were not actually getting
coached)
It is decided that the following data will be held
about Coaches:
• their full name
• their National Insurance Number (NINO) which is
required for paying them
• their hourly rate of pay
• what date they started working for Marazeal
Running
• their contact number (mobile)
• whether or not they are qualified in first-aid
• what particular specialisation they have, be it
cross-country running, marathons or working
with beginners
Runner data will have to include:
• their full name
• their date of birth
• any medical conditions that they have
• what date their membership started
Additionally, we will have to add the following to
the Runners table:
• A RunnerID for each Runner to uniquely identify
them in case 2 runners with the same name,
medical conditions and date of birth join on the
same day
• A FOREIGN KEY called CoachUsed to establish the
relationship, i.e. that each Runner is connected
to one and only one Coach (bearing in mind that
one Coach is welcome to coach multiple Runners)
With this planning done, TABLES can now be
constructed and validation rules enforced.
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Using File > New... in MS Access, choose Blank Database, give it a name and choose a folder in which to save
it:

Blank
database

File name
and location

A blank table may be offered by default, in which case you can go directly to Design View and it will ask you
to save it. To switch into Design View, use either the Home ribbon or the small buttons on the bottom-right of
the MS Access window:
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Home ribbon
Bottom-right of MS Access window
If no table is visible, use the Create ribbon to choose Create > Table:

Press the SAVE button (or use Ctrl+S) and save the first table as COACHES.
Use the Create > Table technique shown above to create a second table and save it as RUNNERS.
Having built the 2 tables, the field structure of each table can now be created and validation can then be
enforced. This is achieved in Design View.
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Validation
Ensure that you are in Design View when performing the following tasks.

Type Check
As each field is given a name, its type must be stated. This is compulsory, so the data type check is thus
enforced from the point of creation onwards.

Here is an overview of the data types on offer:
DATA TYPE

EXPLANATION

Text

Up to 255 characters (remember that a space counts as a character) of text

Memo

Up to 63,999 characters of text

Number

Numeric data that can be used in arithmetic calculations

Date/Time

Accepts dates between the years 100 and 9999

Currency

Amounts of money up to 4 decimal places (though it could be used as a number
without a currency symbol where 4 dp meets the user’s needs for storing a value)

AutoNumber

Continues the sequence of numbers automatically by adding 1 each time a new
record is introduced (and this value cannot be edited)

Yes/No

Denotes Boolean values, i.e. those that are either true or false

OLE Object

A multimedia file such as a spreadsheet, graphic or sound file

Hyperlink

A link to another location

Attachment

A slightly more flexible alternative to using OLE Object

Lookup

This launches a wizard that will either permit the user to define a custom-built list
of values or build a relationship to a primary key of another table

Additional settings linked to the data type can be applied once the data type is chosen, e.g. how will
dates look when presented to the user, and which currency symbol (if any) will be shown? These are not
“type checks” as such, but choosing from one of the data types on offer is what enforces the type check
as a means of validating input. If a Date/Time value is expected and the user attempts to enter only letter
characters, then a type check will intercept the error and produce an appropriate error message.
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For the RUNNERS table, the settings for data types will be:

CHECK YOUR UNDERSTANDING:
Q1 Why was RUNNERS.MedicalNotes set to Memo instead of Text?
Q2 Explain why Yes/No is a suitable data type for COACHES.FirstAidQualified but not for RUNNERS.
MedicalNotes.
Q3 RUNNERS.RunnerID is an AutoNumber but COACHES.CoachNINO is not. Explain the impact of these
data type decisions in terms of the speed of entering a new record in each table.

Format Check: Input Masks
When either the:
• Text
• Date/Time
• Number
• Currency
...data type is used, a FORMAT CHECK can be applied by using an INPUT MASK to define which type of
character can exist in each position in the text string. By applying an input mask that involves compulsory
characters, a minimum length requirement is enforced.
Input masks can be keyed in or selected from the built-in list in this box which is found at the bottom of the
screen when in Design View:

There are 2 opportunities to apply an input mask to a Text field: COACHES.CoachNINO and COACHES.
MobilePhone.
To validate COACHES.CoachNINO, the National Insurance Number format is 2 letters, 6 numbers and then
one last letter, and it only uses uppercase letters. This yields:
Input Mask >LL000000L
...where L represents a compulsory letter, 0 represents a compulsory numeric digit and > will force all letters
to be shown in uppercase.
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To validate COACHES.MobilePhone, the (fake) mobile phone numbers are set to always start with 05 followed
by 9 more digits. This yields:
Input Mask “05”000000000
...where “05” represents a compulsory string of 2 characters that will always be present in the sequence, and
0 represents a compulsory numeric digit like we saw in COACHES.CoachNINO. The compulsory 05 pattern
can also be expressed as \0\5 instead of using the double quotation marks.
If you wish to make your own custom-built input mask, here are the characters that can be used in its
construction:
CHARACTER MEANING
Numeric characters
0

Compulsory numeric digit

9

Optional numeric digit

Alphabetic characters
L

Compulsory letter

?

Optional letter

>

All letters hereafter will be uppercase, like a postcode

<

All letters hereafter will be lowercase, like an email address

Mixed
A

Compulsory letter or numeric digit

a

Optional letter or numeric digit

&

Compulsory character or space

C

Optional character or space

#

Optional numeric digit, + sign, – sign or a space

There are some characters that are widely-known and can be written in directly without requiring a \
character before them, e.g. dates can be written 00/00/0000 instead of 00\/00\/0000. The particular
characters that this will work with depends on the country settings on your clock in Windows.
Common input masks are available already in MS Access. While the Input Mask field is active, a small button
with a “...” symbol on it will be visible on the right hand side. By clicking it a box of options will appear from
which the user can select the one they wish to use:

Input masks can include additional settings because a full input mask comprises 3 subsections separated
by semi-colons, like this: 00\-00\-00;0;_
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This input mask describes a bank sort code. The left-hand side is three pairs of numeric digits separated by
compulsory hyphens. Between the 2 semi-colons is a 0, which indicates that the hyphens will be stored as
part of the sort code. If we were to use a 1 instead, the hyphens would appear on the screen when we see a
sort code, but would not be stored in amongst the digits. Finally, to the right of the final semi-colon is an
underscore. This is the character that will appear on the screen to show the user that a character is expected
to be typed into this position inside the field.
CHECK YOUR UNDERSTANDING:
Q1 Explain what this mask will achieve: >L<LL????????????
Q2 #09 is an input mask. Which of these will pass its validation check: (a) -90 (b) +6 (c) 4
Q3 Northern Irish landline phone numbers tend to use (028) followed by an 8-digit pattern. Construct a
suitable input mask.
Q4 Write an input mask for an 8-digit bank account number.
Q5 On the front of a credit card is a 16-digit pattern where the spaces are merely shown to make the
number more readable. Construct an input mask to store a credit card number’s 16 digits in such a
way that it does not store the spaces, but shows them when the user views a credit card number. The
user should see an underscore character as a placeholder for any digit that has still to be keyed in.
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Lookup Lists
We can use two lookup techniques to aid validation:
• Use a customised lookup list where you type in the values that you want
• Look up the value in another table

Customised Lists
Occasionally, a field will only need to hold one of a small number of optional values. In developing
COACHES.Specialisation, it is anticipated that when a new Coach starts working for Marazeal Running, their
specialisation can be selected from a customised list:

Setting up such a list when the table is built doesn’t immediately enforce the rule that you MUST choose one
of the values given, so there is a second step that must be carried out in order to LIMIT the user to only the 4
specialisations shown. To build a list like this:
1

Go to COACHES.Specialisation in Design View of the COACHES table and call up the Lookup Wizard via the
menu option at the bottom of the list of possible data types:
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2

Choose the second radio button: “I will type in the values that I want” and press Next when it is selected:

3

Key in the full list working downwards through the boxes provided (pressing the down arrow key or
clicking the mouse each time) and eventually press Next:

4 Press Finish on the final screen.
So far, the combo box (i.e. drop-down menu) has been put in place to enable the user to select one of the 4
available specialisations from the list. However, the user is still free to type in any other value of their choice.
In order to prevent this, enter the following:
• Validation Rule “Marathon” Or “Short Sprint” Or “Cross Country” Or “Beginners”
• Validation Text You must choose from one of the 4 available specialisations
A convenient way to quickly obtain the list of values for the Validation Rule is to visit the Lookup tab at the
bottom of the screen and copy the Row Source property for pasting into the Validation Rule. However, before
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clicking the mouse outside of the Validation Rule property box, the semi-colons must all be replaced with the
word OR. MS Access will adjust the capitalisation of the word OR itself.
By having the drop-down menu, the user interface has been improved and thus faster data input times have
been achieved. By enforcing the validation rule there is much less likelihood of an erroneous data value
making its way into the system, e.g. a misspelt word that was intended to match the values found in other
rows.

Relationships: Looking up another table’s values
Marazeal Running is all about matching Runners to suitable Coaches. In order to link a Runner to a Coach,
we identify 1 Coach per Runner that will do the coaching. However, each Coach could end up coaching more
than 1 Runner.

Coaches

Runners

Having understood that this is the nature of how the business works, we can interpret the diagram and see
that each record in the RUNNERS table is going to “refer to” or “look up” 1 record in the COACHES table. The
field which will do this job is RUNNERS.CoachUsed because it will refer to 1 of the Coaches that already exists
in the Coaches table. Unlike with custom-built lookup lists, we don’t need to enter the data this time; it
already exists and is available.
COACHES.CoachNINO is the PRIMARY KEY of the COACHES table, uniquely identifying all Coaches even
when two or more Coaches have very similar or identical details.
RUNNERS.CoachUsed is a FOREIGN KEY that will “look up” the relevant value of COACHES.CoachNINO in
order to relate a Runner to a Coach. RUNNERS.CoachUsed will thus contain a copy of the National Insurance
Number of that Runner’s assigned Coach.
To link the primary key to the foreign key, we establish a relationship as follows:
1 Close any tables that are open apart from RUNNERS.
2 Select the field called CoachUsed and call up the list of data types, launching the Lookup Wizard from
the final option in the drop-down menu:
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3

Choose the first radio button: “I want the lookup column to look up the values in a table or query” and
press Next:

4

Select TABLE: Coaches and press Next:

5

Include ALL fields using the >> symbol and press Next:

6
7

Skip the SORTING option and press Next.
Clear (untick) the checkbox that says “Hide key column (Recommended)” and press Finish (or else use
Next > Next > Finish).
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8 Allow MS Access to save the changes.
9 Close the RUNNERS table.
10 Use the ribbon to navigate to Database Tools > Relationships. If nothing appears, press “Show All
Relationships” or double-click each table’s name once.
11 Double-click on the black join line and tick “Enforce Referential Integrity”. Press OK.

12 Save and close; the line should now show a 1 and an infinity (∞) symbol.
There is now a live link between RUNNERS and COACHES. Test this by populating the tables with data,
starting with COACHES. When you go to enter the RUNNERS data you will find that you can select a Coach
from a drop-down menu in the CoachUsed field. Sample data is shown here; feel free to copy it and try
making changes of your own.
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COACHES table – Sample data

RUNNERS table – Sample data

Referential Integrity
Referential integrity makes it ESSENTIAL that any value entered in the foreign key (RUNNERS.CoachUsed)
field has a matching value in the corresponding PRIMARY KEY (COACHES.CoachNINO) field. This is a form of
validation too: it protects the integrity of the data by insisting that all relationships/links between records of
multiple tables are valid at the point of creation.
CHECK YOUR UNDERSTANDING:
Q1 What is achieved when a lookup list defined by a database developer is given an accompanying
Validation Rule? What would have happened if this step had not been carried out?
Q2 If all of the hard disks in the world have a unique serial number and all the laptops in the world have
a unique laptop number, how would you use primary keys and foreign keys to link a table of LAPTOPS
with a table of DISKS assuming that every laptop is allowed to contain multiple hard disks?
Q3 Explain the concept of referential integrity.
Q4 What would need to change in the Marazeal Running database if a runner wished to change over to
another Coach?

Other Validation Rules
Length Check
LENGTH checks are achieved in Text fields by entering the maximum quantity of characters allowed into the
Field Size property:

The concept of a LENGTH check is not straight-forward to understand for numeric data because it refers to
the number of bits used to store the number on disk rather than the number of significant figures or digits
used to express the number. Nevertheless, the Field Size of a number determines the amount of memory
consumed per record by that field:
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Numeric
Field Size

Size
(bytes)

Byte

1

Integer

2

Long Integer

4

Single

4

Double

8

Text data will take up 1 byte per character, so specifying that 11 characters are allowed limits the maximum
memory consumption to 11 bytes, making the database space efficient.

Presence Check
To insist that data is entered into a field you can set the Required property to Yes. The Text and Memo data
types have an additional setting immediately underneath called Allow Zero Length and this can be set to
No to ensure that fields are not left blank.

A presence check being applied to RUNNERS.JoinDate

(...on Text and Memo fields only)

Range Check
This is achieved by inserting a Boolean expression into the Validation Rule property, and a suitable error
message can be included in the Validation Text property for the user to see when the rule is violated.
When using the Number or Currency data types, you can specify that the numeric value must lie above,
below and/or between certain values. No currency symbols are used to enforce range checks on Currency
data. You can use functions such as Date() to retrieve the current date from your computer’s operating
system.

Here is a range check being applied to RUNNERS.
JoinDate along with a suitable error message in the
Validation Text property

COACHES.HourlyRate does not use
the £ sign in the validation rule

This is what the user will see if they enter a date in the future into RUNNERS.JoinDate:

Complex Boolean expressions for dates could be e.g.: <=Date() – (365*18) , meaning that the date entered
must lie on or before this day 18 years ago (approximating a year to 365 days obviously ignores leap years).
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These two Boolean expressions for numeric data are equivalent and either one can be keyed in as a range
check in the Validation Rule property box:
• Between 9.5 and 10.92
• >=9.5 and <=10.92

Other Useful Settings That Are Not Validation Rules
Decimal Places
A number or currency value is stored in a database using the rules that apply to the chosen data type and
number format, but by setting the number of decimal places to a fixed value, the user will see the number
shown to that number of decimal places.

The Number data type can
have its d.p. fixed by setting the
Format to Fixed

2 d.p. is the default (Auto) for all
Currency values

Captions
Database designers often use field names such as HourlyRate
(shown) without spacing the words apart. This simplifies the reading
of field names when they are used for coding purposes in advanced
applications and it is a widely accepted standard in almost all
computer programming environments that all programmers are
used to.
However, a good user interface will show field names using excellent
English grammar. By filling in the Caption property for any fields
with ungrammatical names, the wizards in MS Access that build the
user interface will use the caption in lieu of the field name (as per
Hourly Rate in the default form generated, as shown).
Over the development of a large-scale MS Access database, the
captions will be used multiple times as new forms and reports
are developed. This decreases the likelihood of ungrammatical or
erroneous field names making their way onto the user interface.
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Default Values
When the majority of new records are going to use a certain value, it makes sense to reduce the user’s
workload by removing the need to enter anything in those cases.
A default value can be used when it is well-known for instance that most customers are male, so we set the
Gender field to have a default value of “Male”, and then when the occasional female customer joins it can be
adjusted to “Female”.
To insert today’s date you call the function
Date() to retrieve today’s date from the clock/
calendar of your computer’s operating system
The Yes/No data type does not offer validation
rules but it does allow the database developer
to set the Default Value property

The Yes/No Data Format
Set the Display Control in the Lookup tab of Yes/No fields to set how they appear on forms:

Check Box

Text Box

Combo Box
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Forms & Subforms
When data is collected from a population, paper forms known as turnaround documents or data capture
forms may be used. If this is the case then the data should be verified when it is input via the keyboard.
Other options for gathering data include automatic data capture through sensors, thus avoiding the use of
data capture forms.
When entering data into a relational database, an on-screen form can be developed that features standard
tools such as combo boxes (drop-down menus), checkboxes and text fields to hold the values of individual
fields. Forms can be set up to show one record or multiple records at a time, they can include linked
subforms and they can be styled to create a personalised colour scheme and user-friendly layout.

Creating A Form
Firstly, identify your data source, which is likely to be a table. In theory, a query could be used as the data
source and the form would not be used for input but merely as a way to view the data on the screen, perhaps
with most or all of the fields locked (uneditable).
Close all other database components that are currently open.
The fastest path to creating the form is clicking once on the name of the table so that it is highlighted in the
Navigation Pane, and then pressing the Form button in the Create ribbon:

This will produce a form and show it in Layout View. Switch to Form View and observe the following
features:
1. The name of the form will match the name of the table
2. There is a default title and logo in the Form Header zone (which is clearly delimited in Design View).
3. The captions set up in the design of the table will be used to label the components, but if any captions
were omitted then the field name will be used. In all cases, a colon is appended.
4. The form is showing 1 Coach record at a time. Down the left hand side is a tall bar with a small black
triangle. This is called a record selector and indicates that the full data set spanned by the bar is one
record, and the black triangle says that this is the currently selected record. If this form showed multiple
records there would be more than one tall bar and only one of them would contain the black triangle.
5. At the bottom of the form are some miniature navigation buttons to let you step forwards and
backwards through the individual Coach records.
6. Specialisation has been treated as a combo box (drop-down menu) because we built a customised
lookup list when setting up this field.
7. There is a subform to list all of the Runners assigned to that Coach.
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The form that has been generated is largely suitable, but the subform is in datasheet layout and this is
somewhat inflexible. It would be preferable to have full control over the placement and style of fields in this
form.
Here is an alternative approach to creating a form. If you have created a COACHES form, delete it.
We will proceed with developing a RUNNERS form initially and then return to developing the COACHES form
so that it contains a subform listing all of the Runners assigned to each Coach.
1

Select the table to use as the basis of the form and click on it once only in the Navigation Pane. Select
RUNNERS this time:
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2

Use the ribbon to navigate to Create > More Forms > Form Wizard:

3

Ensuring that the RUNNERS table is listed in the combo box at the top (which it should be because you
single-clicked it earlier), use the >> button to use all fields:

4

Select Columnar layout and press Next. Tabular would show all Runners on one form, Datasheet would
be one grid similar to a spreadsheet grid, and Justified would be similar to Columnar but would pack the
fields on to the screen in a less desirable layout:
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5

When asked for a style, select None so that you can style it your own way later, but note that if you are
developing a large database package you may benefit from choosing one style and using it consistently:

6

You can rename the form and choose whether to open it in Design View or Form View. Open it in Form
View and have a quick look before changing things.

7

Save your Form if the wizard does not add it to the Navigation Pane automatically.
TIP
Many users toggle between Design View and Form View and do not use Layout View. If you wish to turn
Layout View off, this can speed up the transitions between Design and Form View as you can simply click
the large button on the ribbon without using the drop-down menu each time. To disable Layout View, go
to the Office Button > Access Options > Current Database and clear the checkbox marked “Enable Layout
View”. This is not necessary and comes down to personal preference.

Switch into Design View and observe:
1. There is a Form Header zone, a Detail zone and a Form Footer zone.
2. There are gridlines. These can be disabled and enabled via right-click > Grid.
3. The rulers along the top and left are in centimetres. Right-click > Ruler to enable and disable the rulers.
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In order to style the form in a desirable way, carry out the following steps.
1. Remove the automatic layout manager by using Ctrl+A to select all components and then rightclick on any box’s boundary and use Layout > Remove. This means that all fields can now be resized
independently.

2. Use the font controls to enlarge and recolour the title. Transparent boxes like the title box are known as
labels in MS Access; they do not have a live link to any particular database field value and they can be
overwritten at any time. You should also observe that the entire box is affected by the colour changes, so
don’t highlight the letters; it’s best to select the boundary of the box and then apply the font settings as
the settings must apply to the whole box.
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3. Modify the background shading of each of the zones on your form by right-clicking on a space where
there are no other boxes present.

4. Using your mouse, lasso the text boxes that show the names of the fields and change their font settings.
Do the same for the labels on the left of the text boxes too, perhaps right-aligning or emboldening the
labels.

5. Resize the fields individually to suitable sizes by single-clicking on each field and individually resizing
the box from the right hand side inwards:
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6. As you preview your form in Form View, you may notice that some
Date/Time fields offer a date picker tool but others don’t. This is
because when you put an INPUT MASK on a date it usually disables
the date picker. This is not something you have done incorrectly!

7. A powerful tool in setting up your form is the Property Sheet which appears as a long list of options
down the right-hand side of the screen when it is on. It can be switched on and off from the Design
ribbon. Whilst it is on, click on any part of your form to view the details of its properties.
8. Double-click the small square where the 2 rulers meet on the top-left of the Design View window. Look at
the Property Sheet, go to the All tab at the top and scroll down to find Record Selectors and Navigation
Buttons. Switch both of these to “No” by double-clicking on the word “Yes”, using the combo box or
typing it in.

9. To replace the buttons that have been lost, we will now insert some full-sized ones which are more userfriendly. We will need buttons to:
•
•
•
•
•
•
•
•
•

Step forward by 1 record
Step back by 1 record
Go all the way to the first record
Go all the way to the last record
Find a record based on a search term
Add a new record (i.e. a new Runner)
Delete the Runner shown on the form
Save whatever has been done
Close the form

Press the button marked “Button” on the ribbon and drag out a rectangular shape of any size into the Detail
zone of the form. The Command Button Wizard should pop up, but if it doesn’t then look again at the ribbon
and check that the “Use Control Wizards” button is pushed inwards. When doing the 4 navigation buttons
and the Find button, these are all in the Record Navigation category, but you will have to switch categories
to find the others. Redo this 9 times and observe that the buttons initially have fixed sizes when pictures are
used, and you have the choice of picture icons or text:
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If any button uses an icon that is not self-explanatory, you can use the “Aa - Label” button on the ribbon to
insert a small text box next to it and caption it.
10. Insert a logo in the Form Header box by using the ribbon to find the Image icon, which may require you
to expand a menu of icons so that you can see all of the available icons. You may wish to use Property
Sheet > Format > Size Mode > Stretch in order to make it easier to resize the logo.
11. If you wish to change borders on any images or text boxes, select them and use the Property Sheet to set
the Border Style to Transparent/Solid/etc. The same applies to shading.

The final form should be self-explanatory, clear, easy to use and all data should be visible without having to
scroll horizontally (because the form is too wide in terms of screen space) or highlight within a field (because
the field is not wide enough).

Creating A Form With A Subform
Earlier we discarded the COACHES form because the subform used a datasheet layout, depriving it of
flexibility when it came to functionality and presentation.
Follow these steps to build a subform that can then be treated with the techniques described in the previous
section about styling a form. The numbering here corresponds to the 7 steps (with screenshots) shown
earlier for setting up a form initially.
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1. Close all other database components. Select the COACHES table by single-clicking it on the Navigation
Pane.
2. Launch the Form Wizard.
3. Select the COACHES table and bring in all data via the >> button, but before proceeding, change the
combo box to say RUNNERS and use the >> button to also bring in all the data from the RUNNERS table.
You’ll notice that you’ll see dot notation being used, e.g. RUNNERS.Forename and COACHES.Forename in
order to tell which is which because both tables contain Forename fields.
4. You will be asked about organising the two tables into a form with subform, and the option you should
choose is “Form with Subform”:

Press Next and you will be asked to choose between Tabular and Datasheet layouts for the subform; choose
Tabular so that all of the Runners who are coached by a Coach will be listed all at once under that Coach’s
name.
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5. When asked for a style, select None so that you can style it your own way later.
6. You can rename the form and the subform and choose whether to open them in Design View or Form
View. Perhaps make it clear that COACHES is the Main Form by amending the name, but this is personal
preference. Open them in Form View and have a quick look before changing things.

7. Save the form with subform and switch into Design View to start modifying the outer form. We will deal
with the subform eventually; it is clearly far too large.
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Applying the same techniques as before to the outer form brings us to:

TIP
At this point it is advisable but not strictly necessary to save the form, close it and open the subform on
its own from the Navigation Pane. This has one major advantage: when the subform is single-clicked on
the main form, this activates it, but you have to click a second time to cause a change in the subform.
This can become a nuisance during editing.
Open the subform on its own. It should be the only database component open at the time. We see multiple
record selectors, a blank record ready to receive new data, and a poor layout.
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Applying the same skills as before, we can:
• Turn off the record selectors and default miniature navigation buttons, BUT we
will only insert a delete button alongside the record in Design View because we
don’t need navigation (we need only scroll up and down), we don’t need an add
button (as there’ll always be a blank row at the bottom) and the save and close
buttons on the outer form will affect the inner form directly too.
• Remove the automatic Layout Manager (Ctrl+A then right-click any box’s
boundary and use Layout > Remove)
• Adjust the sizes (horizontally and vertically) of all the text boxes of the fields
themselves and the label boxes containing the column headings (field name
captions). Since the column heading label and the field’s text box are always
going to line up with each other, it is advisable to lasso them into a pair before
resizing them horizontally. Towards the end, lasso the entire top row of column
headings and nudge them up using the ARROW KEYS to fill the gap at the top
of the form (see gap #1 below). The “Detail” heading bar can then be dragged
up to save space using the mouse. A small gap (indicated as gap #2 below) is a
good idea as it helps to separate the Runners from one another when there are
multiple Runners listed on a Coach’s subform.

Afterwards it will be more compact at the top:

• Use font colouring, alignment, background shading etc. to style it visually
• Save and close the subform when completed.
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Upon reopening the outer form, the subform may need some further adjustments on the outer or inner
forms. Looking at it currently, the main form needs to be shuffled around slightly and have the subform’s
container box resized so that the horizontal scroll bar goes away. The subform’s title shown on the left is not
a good use of horizontal screen space either and can be moved or even deleted.

Here is the final outcome, shown with the ribbon minimised to hide the vertical scrollbar:

A vertical scrollbar is an acceptable and in many way inevitable feature of a subform that could end up
containing tens or hundreds of values, but being able to see all fields of the subform across the screen
without any horizontal scrollbars is a worthwhile pursuit from a design point of view as it is of great
assistance to the end user.
You will also see that the captions entered when designing the tables have led to crystal clear labelling of all
fields without any additional effort.
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TIP – EXTENSION EXERCISE ONLY
The subform shows the RUNNERS.CoachUsed value, but this will ALWAYS be an exact match for the
COACHES.CoachNINO value shown on the outer form. On the outer form we are looking at the PRIMARY
KEY of the COACHES table. On the subform, we see RUNNERS.CoachUsed which is the FOREIGN KEY that
refers to the CoachNINO value.
Since these 2 values are always going to be duplicates of each other, we COULD hide the value on the
subform because it is wasteful of horizontal screen space.
To do this, we CANNOT DELETE RUNNERS.CoachUsed because this would disconnect the form and
subform!
What we do instead is shrink the field and its title down to a very small horizontal width and then use
the first option on the entire Property Sheet to set them to be Visible=No.
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CHECK YOUR UNDERSTANDING:
Q1 What are the key components that you should add to a form?
Q2 What would you consider to be GOOD PRACTICE in designing an on-screen form?
Q3 What do the following terms mean in the context of form design in MS Access:
The Detail zone
Layout Manager
Navigation Buttons
Border Style
Image Size Mode
Subform
Columnar v Tabular v Datasheet layouts
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Macros
A macro is a single command that when executed will carry out a sequence of other commands. Whenever
a user runs/executes a macro, all of the commands bundled into the macro are brought in and executed in
their defined order.
Having macros available reduces development time during the building of new systems. It also helps to
prevent the introduction of errors when an existing task may otherwise have to be rebuilt or somehow
replicated.
This macro tells the user that they are about to send 2 print jobs to the printer. It then opens both of the
reports in Print mode (automatically sending them to the printer), and alerts the user that it has done so
and immediately shuts down the database. This macro has been given the name (identifier) “Backup and
Shutdown”. The macro can now be included in a menu of the database so that the user can press just 1
button to run this sequence of commands. The user could get very frustrated if they shut the database
without printing one of the two reports that they needed.

CHECK YOUR UNDERSTANDING:
Q1 What is a macro?
Q2 What happens when a macro is run?
Q3 What buttons on the system’s menu might the user have had to press
to achieve the same outcomes as the macro has done above?
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Menus
A menu system allows the smooth navigation of a set of database components (forms, reports, charts etc.)
and thus improves usability. Menus can also be password-protected to restrict access to certain parts of the
system.
The Switchboard Manager tool in MS Access helps with the development of menus. To switch on the
Switchboard Manager, close any database components that are open and:
1. Go to the small icon expansion menu above the ribbon and choose “More commands”
2. Change the “Choose commands from:” combo box to “All Commands”
3. Identify the “Switchboard Manager” tool (they are alphabetically sorted)
4. Click on “Add >>”
5. Press OK. The Switchboard Manager icon will now appear above the ribbon.

On the main switchboard manager screen there will be a list of all of the menus, known as “switchboard
pages”. These behave like web pages in that you can build links between them, but they can only hold a
maximum of 8 commands each.
We will start by building a simple 1-page menu.
Double click where it says “Main Switchboard (Default)” to open that particular menu for editing:
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Press New and fill in the settings as shown in the screenshot below before pressing OK:

Press New every time in order to include all of the following in the menu:
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Since there are now 7 out of a possible 8 commands on the menu, if we want to add any more we can build
a new menu page and build a link to it. To do so, we could close out of the screen that we are in and return
to the first menu entitled “Switchboard Manager” and subtitled “Switchboard Pages:” and build a new menu
page there.
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Here is our end result in its default state, accessible from the list of FORMS on the Navigation Pane:

This is customisable but...
WARNING
Use the Switchboard Manager AND ONLY THE SWITCHBOARD MANAGER for all editing of the
switchboard’s menus.
Switchboards are temperamental and you should NEVER DELETE a component from a switchboard
in Design View! If you wish to hide a component, use the Property Sheet and set Visible=No as the
first property for that component.
Similarly, a table will have appeared as part of the automated management of switchboards. DO
NOT OPEN OR INTERFERE WITH THAT TABLE IN ANY WAY.
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If you wish to change colours, change fonts, insert logos and insert labels, this will all work perfectly well by
toggling the main switchboard into Design View:
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To round off the development of the system, set the following setting by going to the Office Button > Access
Options > Current Database > Display Form:

This will launch the Switchboard automatically each time the database file is opened.
CHECK YOUR UNDERSTANDING:
Q1 What is the difference between a switchboard and a form?
Q2 How do you cope with the limitation on switchboards that they can only handle 8 commands per
switchboard page?
Q3 Explain why a switchboard is useful.
Q4 Explain step-by-step how you would add a newly-developed report to the existing Marazeal
Switchboard

Introduction to reports
When you use a database, you typically use reports to view, format, and summarize data. For instance, you
might create a list-type report to display phone numbers for all your contacts, or a summary report to total
up the sales for your company across different regions and time periods.
Parts of a report
Report Header: This section is printed just once, at the beginning of the report. Use the report header for
information that might normally appear on a cover page, such as a logo, a title, or a date. When you place a
calculated control that uses the Sum aggregate function in the report header, the sum calculated is for the
entire report.
Page Header: This section is printed at the top of every page. For example, use a page header to repeat the
report title on every page.
Group Header: This section is printed at the beginning of each new group of records. Use the group header
to print the group name. For example, in a report that is grouped by product, use the group header to print
the product name. When you place a calculated control that uses the Sum aggregate function in the group
header, the sum is for the current group.
Detail: This section is printed once for every row in the record source. This is where you place the controls
that make up the main body of the report.
Group Footer: This section is printed at the end of each group of records. Use a group footer to print
summary information for a group.
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Page Footer: This section is printed at the end of every page. Use a page footer to print page numbers or perpage information.
Report Footer: This section is printed just once, at the end of the report. Use the report footer to print report
totals or other summary information for the entire report.
Note: In Design view, the report footer appears below the page footer. However, in all other views (Layout
view, for example, or when the report is printed or previewed), the report footer appears above the page
footer, just after the last group footer or detail line on the final page.
Understand controls
Controls are objects that display data, perform actions, and let you view and work with information that
enhances the user interface, such as labels and images. Access supports three types of controls: bound,
unbound, and calculated:
Bound control: A control whose source of data is a field in a table or query is a bound control. You use bound
controls to display values from fields in your database. The values can be text, dates, numbers, Yes/No
values, pictures, or graphs. A text box is the most common type of bound control. For example, a text box
that displays an employee’s last name might get this information from the Last Name field in the Employees
table.
Unbound control: A control that doesn’t have a source of data (a field or expression) is an unbound control.
You use unbound controls to display information, lines, rectangles, and pictures. For example, a label that
displays the title of a report is an unbound control.
Calculated control: A control whose source of data is an expression rather than a field is a calculated control.
You specify the value that you want in the control by defining an expression as the source of data for the
control. An expression is a combination of operators (such as = and + ), control names, field names, functions
that return a single value, and constant values. For example, the following expression calculates the price of
an item with a 25 percent discount by multiplying the value in the Unit Price field by a constant value (0.75).
= [Unit Price] * 0.75
An expression can use data from a field in the report’s underlying table or query, or from a control in the
report.

Create a simple report
You can create a variety of different reports in Microsoft Access 2010, ranging from the simple to the
complex. This section describes the different tools available for creating reports, and for which situations
each one is recommended.

Choose a record source
The record source of a report determines which fields from your database can be displayed on the report. In
a relational database, related data is usually spread out across multiple tables.
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